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License Agreement

Please read this License carefully before opening the 
package or using ASTARTE software. By opening the 
package or using the software you are agreeing to be 
bound by the terms of this License. If you do not agree 
to the terms of this License, promptly return the 
unused software (including written materials and 
binders or other container) to the place where you 
obtained it and your money will be refunded.

1) Grant of License
ASTARTE grants you the right to use one copy of the 
enclosed ASTARTE software (“the SOFTWARE”) on 
a single terminal connected to a single computer (with 
a single CPU). You may not network the SOFTWARE 
or otherwise use it on more than one computer or 
computer terminal at a time.

2) Copyright
The SOFTWARE is owned by ASTARTE or its 
suppliers and is protected by United States copyright 
laws, international treaty provisions, and all other 
applicable national laws. Therefore you must treat the 
SOFTWARE like any other copyrighted material (e.g. 
books, musical recordings) except that you may either 
make one copy of the SOFTWARE solely for backup 
or archival purposes, or transfer the SOFTWARE to a 
single hard disk provided you keep the original solely 
for backup or archival purposes. You may not copy the 
manuals or written material accompanying the 
SOFTWARE.

3) Rent, Lease, Assignment
You may not rent, loan, lease or distribute the 
SOFTWARE. You may transfer your rights under the 
ASTARTE Software License Agreement on a 
permanent basis provided you transfer all copies of the 
SOFTWARE and all written materials, and the 
recipient agrees to the terms of this agreement. Any 
transfer must include the most recent update and all 
prior versions.

4) Other Restrictions
Excepted as permitted by applicable legislation, you 
may not reverse engineer, decompile or disassemble or 
otherwise reduce the SOFTWARE to a human-
perceivable form.

5) Limited Warranty
ASTARTE warrants that the SOFTWARE will perform
substantially in accordance with the accompanying 
product manuals for a period of 90 days from the dat
of receipt. Any implied warranties on the SOFTWARE
are limited to 90 days. ASTARTE does not warrant tha
the functions contained in the SOFTWARE will meet
your requirements or that the operation of the 
SOFTWARE will be uninterrupted or error-free or tha
defects in the SOFTWARE will be corrected.

6) Customer Remedies, no other Warranties
ASTARTE´s entire liability and your exclusive remedy
shall be, at ASTARTE´s option, either return of the 
price paid or replacement of the SOFTWARE that doe
not meet ASTARTE´s Limited Warranty and which is 
returned to ASTARTE with a copy of your receipt. 
These remedies are not available if failure of the 
SOFTWARE has resulted from misuse, accident, 
abuse or a failure to follow the operation instructions
in the accompanying written materials. Any 
replacement SOFTWARE will be warranted for the 
remainder the original warranty period or 30 days, 
whichever is longer.
ASTARTE disclaims all other warranties, either 
express or implied, including but not limited to implied
warranties or merchantability and fitness for a 
particular purpose, with respect to the SOFTWARE, 
the accompanying product manuals and written 
materials. This warranty gives you specific legal right

7) Nonliability for Consequential Damages
In no event shall ASTARTE or its suppliers or dealers
be liable for any other damages whatsoever (includin
without limitation, damages for loss of business 
profits, business interruption, loss of business 
information, or other pecuniary loss) arising out of th
use of or inability to use the SOFTWARE, even if 
ASTARTE had been advised of the possibility of such
damages. In any case, ASTARTE´s entire liability 
under any provision of this agreement shall be limite
to the amount actually paid for the SOFTWARE. 
Backups are recommended to avoid loss of importan
data.

8) General
This agreement shall be governed and construed in 
accordance with the laws of Germany. At ASTARTE´s
discretion, the law of the country in which the 
SOFTWARE is being used may be applicable. If for 
any reason a court of competent jurisdiction finds an
provision of this License, or portions thereof, to be 
License Agreement
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unenforceable, that provision of the License shall be 
enforced to the maximum extent permissible so as to 
effect the intent of the parties, and the remainder of 
this License shall continue in full force and effect.

© Copyright Manual and Software 1993-1997 
ASTARTE GmbH

All rights reserved.

ASTARTE CD-Copy and ASTARTE M. Pack are 
trademarks of ASTARTE GmbH Germany.

Adaptec Toast and Adaptec Jam are trademarks of 
Adaptec Inc.

All other products and brands are trademarks or 
registered trademarks of their respective owners.

Manual by Mike Evangelist

For any questions about the manual, the software or
our company please contact:

North American Office
ASTARTE USA
689 East County Road D, Suite 207
St. Paul, MN 55117

phone: (612) 483-5338
fax: (612) 483-5448

e-mail: astarte@winternet.com
Internet:http://www.astarte.de

Headquarters
ASTARTE Gesellschaft für Informationssysteme und
Medienintegration mbH
Weberstr. 1 · 76133 Karlsruhe · Deutschland

Fon:++49-(0)721-98 55 40
Fax:++49-(0)721-85 38 62

e-mail:info@astarte.de
Internet:http://www.astarte.de
License Agreement iii
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What is CD-Copy?

CD-Copy is a data extraction tool. It allows you to extract many different kinds of 
from CD’s, including Audio Tracks, PhotoCD Data Tracks, ISO 9660 Data Tracks, H
Data Tracks and more. With CD-Copy, data can be extracted to other storage m
then written to CD-R/CD-RW (writing data back to CDs is accomplished using C
recording software, like Adaptec Toast or Adaptec Jam. Such software is not includ).

Compatibility & System Requirements

CD-Copy is compatible with any CD-ROM drive or CD recorder which uses eit
FWB CD-ROM Toolkit, Apple’s Apple CD-ROM extension, or the Toast CD Read
Extension (included with Astarte Toast CD-ROM Pro and Adaptec Toast) for reading.
Providing you are running your CD-ROM drive with one of these 3 extensions, 
Copy should be compatible with your drive. CD-Copy can work with multiple CD-RO
drives simultaneously, and can work in the background while you use your comput
other tasks. 

A Power Macintosh or Quadra that supports SCSI Manager 4.3 of the Apple 
Manager is required to take advantage of all of CD-Copy’s features.

16 MB of RAM (or more) is recommended.

CD-Copy is compatible with versions of System as old as 7.1 but a newer Syst
highly recommended due to the increased stability we have observed (System 7.5.5 or
later is ideal)

NOTE: Using CD-Copy on a PowerBook with a built-in CD-ROM drive (i.e. 1400
3400) requires that you disable the Apple CD-ROM driver extension first. 
2 What is CD-Copy?



    

CD-Copy Book  Page 3  Wednesday, August 20, 1997  1:57 PM
Installation

To install CD-Copy, simply insert the master floppy disk into your floppy drive and copy
the CD-Copy application to any of your attached hard drives.

The first time you run CD-Copy it will present a dialog asking for your serial number
and personalization information. Enter the serial number printed on the master diskette
label, along with your name and company and click OK.

Copy the application
to your hard drive.
Installation 3
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Technical Support & Updates

Support for CD-Copy is available directly from Astarte. If you are having difficult
using CD-Copy, please review “Frequently Asked Questions” on page 40 before ca

Customer Support Contacts

ASTARTE USA
phone: (612) 483-5338
fax: (612) 483-5448
e-mail: astarte@winternet.com

ASTARTE Germany
phone:++49-(0)721-98 55 40
fax:++49-(0)721-85 38 62
e-mail:info@astarte.de
Internet: http://www.astarte.de

Product Updates

Be sure to register your software by returning the registration card or registering on
(www.astarte.de) so we can notify you of major upgrades as they become available

Maintenance updates are posted on our web site.
4 Technical Support & Updates
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CD-Copy Operation

Overview

There are four basic steps to extracting any data using CD-Copy:

1) Insert the source CD into an available CD-ROM drive
2) Examine the list of data items displayed in the main CD-Copy window (shown
below).
3) Select the desired data, and
4) Save the data to your desired destination.

The Main CD-Copy Window

If you are an experienced Macintosh user, chances are you will be able to figure out how
to use CD-Copy without reading the manual. However, we still urge you to read the
manual as there are many powerful features which you may not discover on your own

Each of CD-Copy’s many options is covered in detail in the following chapter,
“Windows & Menus”.
CD-Copy Operation 5
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WINDOWS & MENUS
7
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Setting Your Preferences

The first time your launch CD-Copy, you should set your preferences. To access th
Copy preferences, select Preferences from the File menu.    In most cases, you will only
need to set these once.

New Discs

This setting determines the behavior of CD-Copy whenever a new disc is detected

• Force Track-At-Once

This setting will prevent CD-Copy from scanning the tracks for the correct pa
settings. Every track will then be in a format which allows the user to make an e
copy with a Track-At-Once recording software like Toast CD-ROM Pro.

CAUTION : If the original CD does not conform to Track-At-Once format the copy w
NOT be like the original. This often happens if the original has something other th
second pauses between tracks. This includes many live CDs and Playstation discs

These four sett ings
determine the format
o f  ex t rac ted aud io
tracks.
8 Setting Your Preferences
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• Track-At-Once Warning

This setting will tell CD-Copy to check the real pause settings of the disc. If these pause
lengths are different than the Track-At-Once assumption (2 seconds) it will inform you
with a dialog box from which you can reset all the pauses (gaps) to Track-At-Once
values.

• No Warning

This setting will tell CD-Copy to check the real pause settings of the disc. If these pause
lengths are different from the Track-At-Once assumption (2 seconds) it will NOT inform
the user about it. This is the best choice if you want to copy an audio CD and want to re-
record it with a Disc-At-Once CD Recording software like Astarte CD-DA or Adaptec
Jam.

Ignore Read Errors

If you have a disc that is scratched or dirty or otherwise has portions that are unreadable,
checking this option will allow you to ‘extract’ what readable data there is. With the
option unchecked, CD-Copy will stop extracting if it encounters an unrecoverable read
error.

XA Save Mode

Many CDs contain XA sectors (i.e. PhotoCDs, Multisession ISO).
Every XA sector consists of a header, subheader and then the data. Using this pop-up
menu you can tell CD-Copy exactly what you want to extract. If you are recording the
track back to another CDR disc, you’ll usually want to leave the setting at Normal. 
If you are otherwise unsure which option to choose, select Normal.

• Normal

Every sector in the saved file will contain sector header, sub-header and data.

• Sub-Header and Data

Every sector in the saved file will contain sector sub-header and data.

• Data-Only

Every sector in the saved file will contain data only. This mode is NOT compatible with
Toast but can be used to extract the raw data of a mpeg track on a VideoCD.
Setting Your Preferences 9
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Allow Rock Ridge Extensions

Normally all file names of ISO discs are limited to the 8.3 format.
Many UNIX ISO discs contain special file extensions called “Rock Ridge Extensio
which allow the longer file names. If you check Allow Rock Ridge Names CD-Co
uses the longer file names. If you uncheck Allow Rock Ridge extensions then CD-
uses the 8.3 format.

Audio Format

This setting specifies which file format will be used for saving extracted audio tra
You can select SoundDesigner II, AIFF, QuickTime or WAV. The normal setting
SoundDesigner II. SoundDesigner II is the only format that preserves indexes and
spacing, for use in Astarte CD-DA or Adaptec Jam. Use the WAV format if you wan
use the sounds on a Windows computer.

• Audio Sampling Rate

Choices for Sampling rate are 44,100 Hz / 22,050 Hz / 11,025 Hz. 44,100 Hz is the
standard for CD audio.

• Audio Channel mode

Choose Stereo or Mono. Stereo is the standard for CD audio.

• Audio Bit Rate

You can choose 8-bit or 16-bit sound. 16-bit is the standard for CD audio.

Secure Audio Read

Checking this options causes CD-Copy to perform what amounts to audio e
checking. Many CD-ROM drives are somewhat imprecise when reading audio; 2 
of the same data will often give different data. If you encounter noise in your extra
audio tracks, check this option. With Secure Audio Read checked, CD-Copy will u
special technique to help ensure that the audio data is extracted faithfully, althoug
extraction process will take much longer.

Read ISRC

Each audio track can have a unique ISRC ‘serial’ number. It takes some time to rea
information from a CD. If you know that the source CD does not contain ISRC cod
you do not want them read, you can uncheck this option to allow for faster 
scanning. 
Note: ISRC codes do not affect the sound of a track; they are simply reference nu
that are used by radio stations and other who have to report their usage of par
tracks. 
10 Setting Your Preferences
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Save Audio Pause

If checked, this option ensures that any pause before an audio track is saved along with
the audio data. If you are recording the tracks back with software that inserts it’s own
pause (i.e. Adaptec Toast) you can uncheck it so that you do not end up with 2 pauses
(one saved with the file and one inserted by the mastering software).

After setting each of these items according to your requirements, click the OK button to
close the dialog window and accept your changes. If you want to discard your changes,
click on the cancel button instead of the OK button. Don’t worry if you don’t fully
understand how a particular setting applies to you. After reading through the rest of this
manual, you can come back here and change your preference at any time.
Setting Your Preferences 11
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The Drive window

This is the main window where you can see and manipulate all the objects o
inserted disc (sessions, tracks, files and folders). You will see the name, type,
length and pause of every object.

The first time you launch CD-Copy, you will see a drive window for each available 
ROM/CD-R drive. If you close the window of an empty drive (no disc inserted), tha
window will stay hidden until you select it from the Window menu to reveal it again. This
is useful if you have more than one CD drive and don’t want their windows to ap
automatically. In addition, since each drive window uses some processor power, cl
unused windows will maximize performance.

This picture shows a typical data disc. This disc has three ISO 9600 data tracks w
in three separate sessions. 

Notice that each session and each directory (Folder) has a triangular icon that c
clicked on to reveal what’s inside. And for each file, the start position on the disc an
length of the file is shown. Invisible files are shown in gray type.
12 The Drive window
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Working With Items in the List

• You can collapse and expand some items by clicking on the small triangle to the left
of its listing.

• If you double-click on an object you get a dialog box with some information about it.

• If you double-click on an object which contains data (like a track or a file) while
pressing the option key you will see a Hex view of that item.

• You can drag the objects from the drive window to the finder. This has the same effect
as the Save… menu entry.

• In the lower left corner you can see how many objects you have selected and how
many bytes they will use if you save them.

Playing Audio Tracks

Now lets look at a disc with audio tracks. When you insert a disc with audio tracks,
playback controls appear at the bottom of the drive window.

To play a track, select the desired track form the drive window. Then click on the play
button. When a track is playing (or you’ve paused the playback) the number of the track,
the current index number and the current time elapsed of that track will be displayed
above the playback controls.

Playback controls
The Drive window 13
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Note: For smooth audio playback from CD-Copy you need at least a 4x CD-RO
drive. CD-Copy plays audio tracks by reading the tracks through the data bus; 
allows playback even from drives that do not have audio connections to the com
However, because it is essentially “extracting” the data as it plays, playback can
interrupted by other processes on your computer. This is normal.The playback fun
is intended to help you select tracks for extraction; it is not a CD player application

Getting Information About An Item

Double-click on any item in the Disc Window to display additional information. T
information and format varies depending on what type of item was selected. Some 
information can be edited (Audio track names, start and end points, index points, etc

Audio Session

Data Track

Data File

Audio Track
14 The Drive window
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Extracting Items from the CD

To extract any data from the inserted CD, simply select it from the list and drag it to the
Finder (or use the Save command in the File menu.)

The progress bar will appear while the data is being saved.

Note: You can still use your Mac for other tasks while CD-Copy is working; just send it
to the background and go on with your work.
The Drive window 15
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File Menu

Close

Closes the front-most drive window. You can re-open it with the Windows menu.

Save

If you select one or more objects in the front disc window you can choose where to
them. 

Save Image...

If you select all tracks of a VideoCD this menu entry is named Save As VideoCD
Image… If you use this CD-Copy will generate one image file ready for Toas
generate a VideoCD.
If you select one or more audio tracks this menu entry is named Save As Audio Image…
If you use this CD-Copy will generate one image file ready for Astarte CD-DA
Adaptec Jam to generate an Audio CD. (you must have your preferences set 
SoundDesigner II, 44,1 kHz 16 bit mono or stereo AND you must have selected
audio tracks.)

Page Setup...

Opens the standard Page Setup dialog.

Print...

Select this command to print the active window in CD-Copy. NOTE: Not all windows
can be printed; you can print the Drive Window, and all sections of the Drive Info 
Disc Info windows.
16 File Menu
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Preferences

This allows you to specify a variety of settings for CD-Copy. See “Setting Your
Preferences” on page 8 for all the details.

Quit

This command closes the CD-Copy application.
File Menu 17
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Disc Menu

Show Drive Info

Selecting this command displays information about the currently active drive the
currently active drive is the drive whose drive window is frontmost.) Click the tabs at the
top of the Drive Info window to switch between the General and Features display.

• General

The first section of the general information is the physical type (SCSI or IDE) of
drive and the installed driver version.
The second section is the drive identification data returned by the Inquiry  command.
18 Disc Menu
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• Features

The Features window shows vendor-specific information about the drive. For some
drives this section will be empty.

If you have multiple CD drives or recorders and want to see the drive info of a particular
drive, bring the drive window with the name of that drive in the title bar to the front and
them select Show Drive Info... 
Disc Menu 19
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Show Disc Info

Selecting this command displays a window with several ‘pages’ of information abou
disc in the currently active drive.

To move between the
various pages of info,
click on the tabs at the
top of the window.
20 Disc Menu
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• Layout

Shows the entire layout of the data on the disc, including track and index start times,
lengths and pauses.

• TOC

Lists the Table of Contents of the disc. Please refer to the standards books (Red Book,
Blue Book, etc.) for complete explanations of the items in the TOC.

• Sessions

Lists information about each session on the disc.

• Additional Info

Lists some additional info about the disc including how much space is taken up on the
disc, and how much (if any) space remains.

Show Disc Layout

Selecting this menu displays the physical layout of the data on the disc in the currently
active drive. 

Data Disc
Jump Back/Forward
Zoom controls

Session name
Track Start & End
Save Start & End
Indexes

Audio Disc
Time line ruler

Waveform Control

Audio Controls

Audio Waveform
Disc Menu 21
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• Jump Back/Forward Controls

Click the left button to move to the previous point (track start, track end, index, etc.
Click the right button to go to the next point.

• Zoom Controls

Click the Zoom In control (+) to see more detail in the window. Click the Zoom Ou
control to see less detail.

• Session Name

Indicates the name of each session in the window.

• Track Start & End

This row shows the beginning and end of each track.

• Save Start & End

This row indicates what part of the given track will be saved when it is extrac
Normally this matches the Track Start & End, but you can move the Start and End p
to new positions by dragging the black rectangles. In conjunction with the wave
display this makes it easy to select specific portions of songs for extraction.

If you double-click on one of the markers, you will get this dialog which allows you
set the values numerically.

If you click on “ABS” then the sector is displayed relative to the minimum value. Th
indicated by “REL”.

• Indexes

If your disc has inter-track indexes, they will be shown here.

Move these markers
to change the start
and end times.

Add index points
to audio tracks by
Command-
cl icking in this
row.

Option-click here
to get a menu of
suggested values.
22 Disc Menu
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• Timeline Ruler

Shows the position of the data on the disc. Units are Minutes:Seconds:Frames.

NOTE: If you press the option key and click in the ruler you get a pop-up menu with all
the points available on the disc. If you choose one of them it will become the left-most
sector of the display.

• Waveform control

A waveform can be generated for audio tracks by clicking on the START icon. Creating
the waveform will take some time depending on the speed of your CPU, the speed of
your CD-ROM drive and the CD being read. The waveform information is saved in the
CD-Copy preferences folder so it can be recalled later. The waveform file for one audio
CD can be as large as 660K. These files may be deleted if you wish, although you will
have to re-generate it if you want to work with the disc later.

• Audio Controls

If the inserted disc is an audio CD, the Audio Controls can be used to play the tracks.

• Waveform Display

The Waveform Display shows a graphical representation of the actual content of the
audio tracks. This is very useful for finding specific points in a song, or for trimming
silence from the start or end of a track. The waveform will not appear until you click the
Waveform START control to read the disc (see above).

Disc Layout Sub-menu

If you have made changes to the disc layout that you want to remove, the Disc Layout
sub-menus allow you to restore everything to their original values by selecting Reset To
Default or to re-read the contents of the disc by selecting Rescan from the Disc Layout
sub-menu.

The Reset to Track-At-Once command resets all track information to values suitable
for Track-At-Once recording.
Disc Menu 23
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Hex View

Hex view lets you view the selected item in hexadecimal form. Click on the file or t
you want to view and then select Hex View… from the disc menu. 

You can look at every readable sector on the disc in hexadecimal format. In additio
get the header and subheader information of XA sectors and the Q-Codes of 
sectors (if your drive supports reading of Q-Codes). 

When viewing tracks or files in this way you can advance to the next sector on the
or go back to the previous sector by pressing the left or right arrow keys (respective
you can use the Previous Sector and Next Sector commands in the Disc menu. 

Go to Sector...

You can also use the Go to Sector command to move directly to a particular sector
Hex view. Select Go to Sector and enter the exact sector you want to go to and
Enter. 

Information about the
sector being viewed.

Hex view

Text view
24 Disc Menu
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Verify Tracks

When you select this command CD-Copy will read all the selected tracks from the
inserted CD, checking for read errors.

If errors are encountered, CD-Copy will display a message:

Eject

This command ejects the disc from the currently selected drive.
Disc Menu 25
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Markers menu

CD-Copy can save Markers which make it fast and easy to jump to any specific po
the source CD. Commands for working with Markers are found in the Markers  menu.

• Add Marker…

If you are in the Hex View window or you have a dialog box on the screen wi
editable sector field you can add that sector to your marker list using this m
command.

• Modify List…

With this you can modify the list of markers.

• Markers

Select a marker from the list to jump to that point in the Layout or Hex view, or to e
the value into an editable field.

NOTE: Markers are saved separately for each CD that you insert, so you can reuse
later. This information is stored in the CD-Copy folder in your Preferences folder.

Double-click on the
marker you want to
edit.
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Windows Menu

The windows menu can be used to bring any open window in CD-Copy to the front. If a
window is not yet open, selecting that window in the Windows menu opens it and brings
it to the front. 

• Log

Selecting Log opens the Log window which contains a history of what actions have been
performed with CD-Copy since launching. 

• Drive Windows

Selecting a Drive window brings that drive window to the front so that it is the active
drive.
Windows Menu 27
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USING CD-COPY
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A Tutorial

With most types of CDs, the copying process is as simple as inserting the disc, sel
the sessions or tracks you want to copy, selecting Save, and then opening the
file(s) in your recording software to write the new disc.

In the following pages we’ll show you, step by step, how to copy some popular 
formats. You’ll see that the basic steps are the same for nearly every disc. If you’re not
sure how to proceed, refer to the format reference chart “How to Copy Various
Formats” on page 36.

NOTE: If you want to make a faithful copy of a multisession disc, remember to re
each session back to CD individually. 
30 A Tutorial
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Copying an Audio CD

1) Launch CD-Copy
2) Insert an audio CD 
3) As CD-Copy scans the disc, a progress bar will appear at the bottom of the main
window.
4) Select the tracks you want to extract by clicking on them in the list. Hold down the
Command key while clicking to select non-adjacent items. To select a whole disc for
extraction, you can choose Select All from the Edit menu.
5) select Save from the file menu. 

The progress bar will appear while the data is being saved.

Note: You can still use your Mac for other tasks while CD-Copy is working; just send
it to the background and go on with your work.

Tracks selected for extraction.
Copying an Audio CD 31
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6) When the tracks are saved, open your CD recording software (Adaptec Toast
shown here), select the Audio CD format, and select the extracted files.

Fine-tuning Your Track Selections

CD-Copy allows you to adjust the start and end point of each index and track befor
extract it. 

This is useful for:

• Selecting just the portion of a track that you want.

• Changing the length the inter-track gaps.

• Moving the start point (Index 1) of a track in relation to the start of the song

• Adding indexes to tracks.

Tracks added to the Toast track list for recording.
32 Copying an Audio CD
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Here’s how it works:

1) With the Disc Layout window visible, click the Start button to scan the disc. 

The waveform will appear on screen as the scan progresses. If you want to stop the
scan click on the Stop button.

Note that the waveform is cached to disk for future use. You can quit CD-Copy and
come back to it later and then waveform will come up immediately instead of having
to wait for the disc to be scanned. For more information on the waveform display, see
“Waveform Display” on page 23.
2) If desired, click on the Zoom In button to get a closer view of the waveform or
click the Zoom Out button to get a better overview of the entire disc. 
3) Make adjustments to the track beginning and end of each track by moving the
divider between tracks. 

4) After you have made any adjustments you desire for each track, click on the close
box to dismiss the track info window. 
5) Select the tracks you want to extract by clicking on them in the list. Hold down the
Command key while clicking to select non-adjacent items. To select a whole disc for
extraction, you can choose Select All from the Edit menu.
6) Select Save from the file menu, the adjustments you made in the disc layout
window will be taken into consideration when the tracks are extracted.

Adjust track start and end
po in ts  by  d ragg ing  the
rectangular markers.
Position the cursor directly
over the element you want to
adjust .  When the cursor
changes to two horizontal
arrows, you can click and
drag the element to move it.

Command-click here to add
indexes.
Copying an Audio CD 33
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Copying Specific Files From a CD

CD-Copy makes it easy to copy selected files and folders from a data CD. As yo
already seen, it’s as easy as drag and drop.

1) Insert your data CD into the CD-ROM Drive.
2) Select the tracks you want to extract by clicking on them in the list. Hold down
Command key while clicking to select non-adjacent items. 

3) Drag the selected items to the desired drive or folder.

CD-Copy will even let you select and save invisible files and folders.

Simply drag and drop to extract files.
34 Copying Specific Files From a CD
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Copying a PhotoCD

CD-Copy can be used to copy multitrack  Photo CDs. (NOTE: due to limitations of CD-
recorders, Multi-session Photo CDs cannot be copied.)

To copy a PhotoCD, 

1) Insert the original PhotoCD to examine the contents. You will find that the disc will
contain various tracks. 
2) Select each track (either by shift clicking or by selecting Select All from the edit
menu). 
3) Select Save from the file menu. 

Now that the tracks are extracted you need to use your CD Recording software to
record the tracks back to a disc. 
4) Launch your CD recording application.
5) Select Multitrack CD-ROM XA  as the format and load the tracks in the
recording software in the same order they were on the original.
6) Write the new disc.

Copying a Multisession ISO Disc

A multisession ISO disc is very simple to copy. 

1) Insert the original multisession ISO disc.
2) Select all sessions of the disc.
3) Select save from the file menu. 
4) When the extraction is complete, quit CD-Copy and launch your CD recording
software.
5) Set the format to Multitrack CD-ROM XA .
6) Add the extracted image file from the first session to the track list.

If a session contained more than one track, be sure to add them all to the track list, in
the same order as on the original. (Do not combine tracks from different sessions.)
7) Write the disc using the Write Session option.
8) Repeat steps 6 and 7 above until you’ve written all the tracks/sessions to the disc.
Copying a PhotoCD 35
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How to Copy Various Formats

Use this chart to determine what format your disc is written in, and how to extrac
data. Look in the first column for the description that matches what you see in the
Copy Disc window, then follow the instructions on the other columns for saving 
writing the data 

If CD-
Copy 
shows

Your CD is 
in this 
format:

How to Save (Save or 
Save As Audio 
Image)?

What format to use 
when writing saved 
data to CD-R with 
Adaptec Toast?

What format to use 
when writing saved 
data to CD-R with 
Adaptec Jam?

Comments

1 HFS track Macintosh 
HFS (Single 
Session/
Volume)

Select the HFS track 
and choose Save from 
the File menu

Use the Disc Image 
format. Click on 
Toast's Data button 
and choose your 
HFS disc image.

N/A

2 or more 
HFS Tracks

Macintosh 
HFS (Multiple 
Sessions/
Volumes)

Select each HFS track 
you want to save and 
choose Save from the 
File menu

Use the Disc Image 
format. Click on 
Toast's Data button 
and choose each 
HFS disc image. 
Write each disc image 
as its own session.

N/A

1 ISO 9660 
track

ISO 9660 
(Single 
Session)

Select the ISO 9660 
track and choose Save 
from the File menu

Use the Disc Image 
format. Click on 
Toast's Data button 
and choose your ISO 
9660 disc image.

N/A If your disc image 
contains Rockridge or 
Joliet extensions for 
UNIX / Windows 95 
long Þle names, do 
NOT mount the disc 
image in Toast prior to 
writing it to disc! (The 
MacOS will cause the 
long Þle names to be 
ignored in favor of the 
8.3 names)

1 or more 
ISO 9660 XA 
track(s) and 
sessions

ISO 9660 
XA (Multiple 
Sessions)

Select each ISO 9660 
XA track/session you 
want to save and 
choose Save from the 
File menu

Use the Multitrack 
CD-ROM XA format 
and click on Toast's 
data button. Add all 
the ISO 9660 XA 
tracks from the Þrst 
session to the track 
list in the original 
order. Write the 
session. Repeat for 
each session.

N/A If your disc image 
contains Rockridge or 
Joliet extensions for 
UNIX / Windows 95 
long Þle names, do 
NOT mount the disc 
image in Toast prior to 
writing it to disc! (The 
MacOS will cause the 
long Þle names to be 
ignored in favor of the 
8.3 names)

1 Hybrid Track Mac/ISO 
Hybrid

Select the Hybrid track 
and choose Save from 
the File menu

Use the Disc Image 
format. Click on 
Toast's Data button 
and choose your 
Hybrid disc image.

N/A
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1 or more CD-
DA tracks

Audio CD Select the CD-DA tracks 
you want to save and 
choose Save (if using 
Adaptec Toast or 
Adaptec Jam) or Save 
as Disc Image (only if 
using Adaptec Jam) 
from the Þle menu

Use the Audio CD 
format. Choose each 
audio track by 
dragging and 
dropping it onto 
Toast's main window.

If you saved the 
Audio as an audio disc 
image, click on the 
Add Tracks button in 
Jam, click on the 
ÒRegionsÓ Radio 
button, then import all 
tracks.    If you saved 
the tracks as 
individual Þles, then 
click on the ÒFilesÓ 
radio button when 
you add tracks.

1 data track 
(any format) 
+ 1 or more 
CD-DA tracks

Mixed Mode 
(Audio + 
data in a 
single 
session)

Select all tracks you 
want to save and 
choose Save from the 
Þle menu

Use the Disc Image 
format, and select 
audio tracks 
(command A). Click 
on Toast's Data 
button and select the 
disc image, then 
choose each audio 
track by dragging and 
dropping it onto 
Toast's main window.

N/A

1 audio CD 
session with 
1 or more CD-
DA tracks + 1 
data session 
with 1 data 
track (any 
format)

CD-Extra Select all tracks you 
want to save and 
choose Save from the 
Þle menu    - or - select 
the data tracks and 
choose Save from the 
Þle menu, then select 
CD-DA tracks and 
choose Save as Audio 
Disc Image (only if using 
Adaptec Jam to write 
the audio session)

Choose each audio 
track by dragging and 
dropping it onto 
Toast's main window, 
then write the audio to 
disc, making certain 
you use the ÒWrite 
SessionÓ button. Then 
use the Disc Image 
format, click on 
Toast's Data button 
and select the data 
disc image.

If you saved the 
Audio as an audio disc 
image, click on the 
Add Tracks button in 
Jam, click on the 
ÒRegionsÓ Radio 
button, then import all 
tracks.    If you saved 
the tracks as 
individual Þles, then 
click on the ÒFilesÓ 
radio button when 
you add tracks. 

Only the audio session 
can be written in 
Adaptec Jam, the data 
session must be written 
with Adaptec Toast

1 audio CD 
session with 
1 or more CD-
DA tracks + 1 
data session 
with 1 Hybrid 
XA track

Enhanced 
CD

Select all tracks you 
want to save and 
choose Save from the 
Þle menu    - or - select 
the data tracks and 
choose Save from the 
Þle menu, then select 
CD-DA tracks and 
choose Save as Audio 
Disc Image (only if using 
Adaptec Jam to write 
the audio session)

Choose audio tracks 
by dragging and 
dropping them onto 
Toast's main window, 
then write the audio to 
disc, making certain 
you use the ÒWrite 
SessionÓ button. Then 
select the Disc Image 
format, click on 
Toast's Data button 
and select the hybrid 
disc image.

If you saved the 
Audio as an audio disc 
image, click on the 
Add Tracks button in 
Jam, click on the 
ÒRegionsÓ Radio 
button, then import all 
tracks.    If you saved 
the tracks as 
individual Þles, then 
click on the ÒFilesÓ 
radio button when 
you add tracks.

Only the audio session 
can be written in 
Adaptec Jam, the data 
session must be written 
with Adaptec Toast

1 ISO 9660 
XA Track + 1 
or more CD-
ROM XA 
Tracks

Photo CD Select each ISO 9660 
XA track and the CD-
ROM XA tracks you 
want to save and 
choose Save from the 
File menu

Use the Multitrack 
CD-ROM XA format 
and click on Toast's 
data button. Select 
the ISO 9660 XA 
track and each CD-
ROM XA track you 
want to write to disc. 
Write all tracks to CD-
R in the same 
session.

N/A

If CD-
Copy 
shows

Your CD is 
in this 
format:

How to Save (Save or 
Save As Audio 
Image)?

What format to use 
when writing saved 
data to CD-R with 
Adaptec Toast?

What format to use 
when writing saved 
data to CD-R with 
Adaptec Jam?

Comments
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1 ISO 9660 
XA Track + 1 
or more CD-
ROM XA 
Tracks + 1 or 
more CD-DA 
tracks

Photo CD 
Portfolio

Select each ISO 9660 
XA track, each CD-ROM 
XA track, and each 
audio track you want to 
save and choose Save 
from the File menu

Use the Multitrack 
CD-ROM XA format, 
and select Audio 
Tracks (command A) 
and click on Toast's 
data button. Select 
the ISO 9660 XA 
track and each CD-
ROM XA track you 
want to write to disc. 
Then drag the audio 
tracks to the Toast 
main window to 
select.

N/A

1 CD-i track CD-i Select the CD-i track 
and choose Save from 
the File menu

Use the CD-i format in 
Toast. Click on Toast's 
Data button and 
select your CD-i disc 
image.

N/A

1 ISO 9660 
Track + 1 or 
more CD-
ROM XA 
Tracks

Video CD Select the ISO 9660 
track and each of the 
CD-ROM XA tracks you 
want to save and 
choose Save from the 
File menu.

Use the Video CD 
format in Toast. Click 
on Toast's Data 
button and select your 
Video CD disc 
image.    (Multiple 
Tracks?

N/A

It doesnÕt 
match any of 
the above

Unknown 
format

Select each track you 
want to save and 
choose Save from the 
File Menu

Use the Disc Image 
format in Toast.

If CD-
Copy 
shows

Your CD is 
in this 
format:

How to Save (Save or 
Save As Audio 
Image)?

What format to use 
when writing saved 
data to CD-R with 
Adaptec Toast?

What format to use 
when writing saved 
data to CD-R with 
Adaptec Jam?

Comments
38 How to Copy Various Formats



CD-Copy Book  Page 39  Wednesday, August 20, 1997  1:57 PM
REFERENCE
39



  REFERENCE

may

 has
auses
t or

ned.
rive
e as

been
ROM

liable

ey

 read
, and
 less

E),
 CD-
s may

CD-Copy Book  Page 40  Wednesday, August 20, 1997  1:57 PM
Frequently Asked Questions

Please refer to this information if you have any trouble when using CD-Copy; you 
find a solution here.

General Read Errors

What causes Read Errors (-36) and how can I prevent them?

These errors indicate that the CD-ROM drive you are using to read the CD
encountered a portion of the disc that it is unable to read. This could have many c
including a flaw in the CD-ROM media, a defect in the CD-ROM reader, dust, dir
other debris on the CD itself, or a CD-ROM reader that needs to be cleaned.

First of all, make sure that the CD you are trying to read has been properly clea
Secondly, if your CD-ROM reader has not been cleaned, check with the d
manufacturer for instructions on how to clean the drive (with some drives, it may b
simple as blowing compressed air in through the door of the drive). If both have 
cleaned, the read errors may indicate a more significant problem with either the CD-
media or the CD-ROM drive itself.

Finally, you can also try modifying the CD-Copy preferences to help assure more re
reading. Specifically, checking the “Secure Audio Read” option, and unchecking the
“Read ISRC” and “Ignore Read Errors” may help alleviate the read errors.

Audio Read Errors

I have a few Audio CDs that play perfectly in my CD-ROM drive, but th
sometimes produce read errors when I’m copying them with CD-Copy.

The process of playing audio from an audio CD is process that is more tolerant of
errors on the source media. Audio CD players have an error correction process
although there may be read errors on the CD, an audio CD player makes them
noticeable or not noticeable at all. In the case of Digital Audio Extraction (DA
however, it’s crucial that all of the data read from the disc without error. As such, the
ROM drive may detect read errors on a CD in the DAE process, although those error
not be detectable when playing the audio CD with an audio CD player.
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Noise In Audio

When I use CD-Copy to extract audio tracks from a CD, I get audio files that
contain noise, like clicking and popping, that is not on the original audio CD.
How can I prevent this?

Chances are that this problem is caused by read errors, so you could address the problem
by following some of the suggestions covered in “General Read Errors” on page 40. Also
note that the problem could be related to Digital Audio Extraction capabilities of the
particular CD-ROM drive that you are using for the audio extraction.

Can’t Read Audio

CD-Copy says that my drive cannot read audio, but it can play audio CDs just
fine. Why is that?

Most CD-ROM drives are capable of playing audio CDs, but not all are capable of Digital
Audio Extraction. You should check with the manufacturer of your CD-ROM drive to find
out of your CD-ROM drive supports Digital Audio Extraction.

Exact Audio Copies

How do I make an exact duplicate of an entire audio CD? I want to make sure
that the length of the pauses between tracks are copied identically.

The simplest way to make an exact duplicate of and audio CD would be to select all of the
tracks within CD-Copy, then to select Save as Audio Disc Image from the File Menu. The
audio disc image that CD-Copy creates, will be a single Sound Designer II file that
preserves all of the information on the original disc, including pause lengths. Each
individual track is designated by a region within that Sound Designer II file. Once you
have an audio disc image, you need CD Recording software that recognizes Sound
Designer II files and regions, such as Adaptec Jam or DigiDesign’s MasterList CD. With
either of those CD Recording packages, you can import the audio disc image file, and
write it to CD-R, producing a duplicate of the original.

If you are using Toast, or another CD recording package that does not recognize Sound
Designer II regions, you cannot make a duplicate of an audio CD using the Save as Audio
Disc Image option. You must save the audio tracks individually, and assuring that the
pause lengths on the copy match the pause lengths on the original audio CD involves an
extra step.

You have 2 options for matching the gaps lengths on your copy to those on the original
CD using Adaptec Toast: 1) Once you have selected the audio tracks in Adaptec Toast, you
can manually edit the gap lengths, using the pause values shown in CD-Copy as a guide
(in the main window, CD-Copy will tell you the length of the gaps between tracks), or 2)
Prior to extracting the audio tracks you can go into the CD-Copy preferences, check the
“Save Audio Pause” Option, save the tracks to your hard drive, then write them to CD-R
with Adaptec Toast after setting all gap lengths to “0” seconds. What this latter option
does is this: it saves the gap as part of the track itself, so that you are actually building X
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seconds of silence (to represent the pause) at the beginning of your track. Both o
should produce a copy that sounds the same as the original audio CD.

TAO vs. DAO

What’s the difference between Track-at-Once and Disc-at-Once?

Track-at-Once (TAO) and Disc-at-Once (DAO) apply to the way information is recor
to a CD-R. In TAO mode, the recorder’s laser (which is what ‘writes’ the information
CD-R) turns off in between each track. This usually results in several sectors bet
tracks that contain no information, or information that is meaningless. These se
between tracks written in TAO mode translate into audible gaps between tracks
standard gap length being 2 seconds. In DAO mode, the recorder’s laser never tur
between tracks, eliminating the blank or meaningless sectors between tracks, and al
for true 0 second gaps between tracks.

Compatibility with CDR Software

Once I’ve copied data off a CD onto my hard drive with CD-Copy, can I use any
CD Recording software to write that information back to a CD-R?

Yes, provided the CD recording software you are using is compatible with the form
the disc image you are trying to write. For instance, when CD-Copy saves a Video C
your hard drive, it does so in the form a White Book Video CD Disc image. As lon
your CD recording software supports the White Book Video CD format, it should
capable of writing that disc image.

In addition, as far as audio is concerned, CD-Copy will allow you to extract audio 
variety of file formats (see CD-Copy Preferences), so that you can choose the forma
is compatible with your CD Recording software.

What Can’t I Copy

Exactly what formats can/can’t CD-Copy copy?

For a list of formats that CD-Copy can copy, please see “How to Copy Various Form
on page 36.

CD-Copy cannot copy discs in the CD+G format (used mainly for Karaoke discs), DVD
discs, PhotoCDs with non-standard gaps between tracks, or audio CDs which conta
in the pause preceding the first audio track.
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Can’t Hear Audio

I don’t hear anything when I am trying to listen to audio tracks. Why?

You may not have your Sound In options set correctly. Open your Sound control panel
and making sure that the Sound In is set to “Internal CD” and that the “Playthrough” box
is checked. 

Sound Control Panel

If you have the Monitors & Sound control panel, make sure that the Sound Input is set to
“ Internal CD” and that the “Listen” box is checked.

Monitors & Sound Control Panel
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Can’t Unmount Volume

I get the following error message: “Sorry, but I cannot unmount volume
Please insure that there is no program using the data of this volume.”

For certain CD-Copy operations, it is necessary to unmount the disc that is inserted
CD-ROM drive. If a file on the disc is in use, the disc volume cannot be unmounted
closing all of the files an applications residing on that CD.

Required Extensions

What system extensions need to be active in order to use CD-Copy, and a
system extensions incompatible with CD-Copy?

In most cases, no extensions are required to use the CD-Copy software. As long as y
using a Macintosh that supports SCSI Manager 4.3.1 and Thread Manager (like a 
Macintosh or a 68040 Macintosh with System 7.5.3 or later) CD-Copy requires no sy
extensions.

Playstation Discs

Can I copy Sony Playstation discs?

Assuming you have CD-Copy, Adaptec Toast and a recorder that can write CD-ROM
tracks which contain both form 1 and form 2 sectors in Track-at-Once mode (you’ll n
to check with the manufacturer of your recorder to find this out), you can cop
Playstation disc. 

Note: Sony Playstation devices can detect copies that are written on recordable dis
unless you have a Playstation that has been altered with a “bootleg” ROM chip, you will
not be able to use copied discs in your Playstation.
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Glossary of Terms

Audio Sectors

Audio sectors consists of sound material which is provided with error correction. They
can not be read directly by a CD-ROM drive, but many drives provide the possibility to
convert the audio data into computer data. An audio sector consists of 2353 bytes of data
which corresponds to 1/75 of a second of playing time of a 16-bit sample at 44.1 kHz.

Audio Tracks

Audio tracks consist of audio sectors. They can be played by any CD player as long as
they are in the first session of a disc.

CD-i

CD-i stands for Compact Disc Interactive. This is a computer system developed by
Philips. It allows play of interactive CD-i discs. Some CD-i players also support the play
of VideoCDs and PhotoCDs

Disc-at-Once

This is a mode of CD recording wherein all tracks are written to disc without an
interruption of the laser. Therefore no runout sectors are written at the end of each track.
Not all CD writers are able to write in this mode and not all CD mastering applications
support writing in this mode.

Form1 Sectors

A form1 sector is a mode2 sector which consists of 2048 bytes of data with error
correction.

Form2 sectors

A form2 sectors is a mode2 sector which consists of 2324 bytes of data with no error
correction. These types of sectors are used for storing audio and video data in XA or
CD-i tracks

Frame

One frame equals one sector. One audio frame is equal to 1/75 of a second

Green Book

The green book document describes the format and functionality for CD-i players and
CD-i discs
Glossary of Terms 45
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Header

A sector’s header consists of information about the placement of the sector on th
and its mode

HFS

HFS is the file system used by the Macintosh. An HFS track on a CD can normally
be read by a Macintosh computer.

Index

Each sector consists of an index between 0 and 99. Index 0 marks a sector as a
sector. Index 1 marks the beginning of a track.

ISO 9660

ISO 9660 is a file system which can be read by many different computer platfo
including DOS, Windows , Macintosh, and Unix.

ISO 9660 XA 

ISO 9960 XA is an Xtended Architecture version of ISO 9660 which allows for mult
sessions on a volume. It is a read-only file system and is able to be read by 
different operating systems (DOS, Windows, Macintosh, and Unix).

ISRC-CODE

The ISRC-CODE (International Standard Recording Code) is the ‘serial number’ o
audio track. Its structure is predefined and it is used to indicate the copyright of an 
track.

Media Catalog Number (MCN)

The Media Catalog Number (MCN) describes the UPC/EAN Bar-code of a dis
consists of 13 digits.

Mixed Mode CD

A mixed mode CD consists of audio tracks and data tracks which are all written i
first session. Data tracks are always placed before the audio tracks so that an au
player recognizes and plays the data and audio. To avoid the structure of having
and data in the same session, the Enhanced CD standard was defined.

Mode1 sectors

Mode1 sectors consist of 2048 bytes of user data with error correction. Each M
sector starts with a synchronization field followed by the header, the subheader, th
data and the error correction.
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Mode2 Sector

A Mode2 sector consists of up to 2324 bytes of user data. Two kinds of Mode2 sectors
exist: form1 and form2. Each mode2 sector starts with a synchronization field followed
by the header, the subheader, the user data and, in form1 sectors, the error correction.

MPEG

MPEG is a compression standard for video and audio data. This standard allows play of
movies in full-screen and full motion from disc.

Multisession

A multisession disc consists of several sessions which are written to disc in several write
procedures. There are two type of multisession disc, those on which all sessions appear
under the same root directory and those on which each volume appears as it’s own
volume. Multisession ISO discs are single volume while Multisession Macintosh HFS
discs are multivolume. 

Orange Book

Name of the standard developed by Philips and Sony for CD-Recordables (CD-Rs). part
II of the Orange Book describes the structure of a blank CD-R as well as the recording
procedure on a physical layer.

Pause

The track spacing (pause between the tracks) of audio or data tracks written in track-at-
once mode consist of 150 sectors (2 seconds) of pause and 2 run-out sectors. The pause
between data and audio tracks on a mixed mode disc written in track-at-once mode
consists of 377 sectors. Discs written in disc-at-once mode do not have fixed track
spacing of 152 and 377 sectors.

Photo CD

A Photo CD consists of one ISO 9660 XA track and several XA tracks. Such a disc can
be played with a Photo CD or CD-i player.

Photo CD Portfolio

A Photo CD Portfolio consists of an ISO 9660 XA track, and XA track and an Audio
Track. Generally this kind of discs are used for interactive presentations.

Q-codes

Q-Codes contain additional information about a sector. The most important information
is the ISRC code and the Indices. These codes are not provided with error correction.
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Red Book

Red Book is the standard for digital audio defined by Sony and Philips. It define
format in which a disc has to be recorded to be played in an audio CD player. It
describes what a CD player has to do to play audio CDs correctly.

Run-Out-Sectors

Run-out-sectors originate from the fact that the laser cannot be switched
instantaneously after writing. Therefore two sectors are destroyed. On discs writt
track-at-once mode these sectors appear at the end of every track.

Sector

A sector is the smallest data unit on a CD. Its size can take up to 2352 bytes. The
three different kinds of sectors: mode1, mode2 and audio. Additional P-Q code
saved for each sector. 75 sectors correspond to one second of data (1 sector =
second).

Session

A session is a union of several tracks. For each recording procedure one sess
created which contains all tracks of that recording procedure. A disc which is writte
more than one session is called a multisession disc.

Subheader

A sector’s subheader consists of information about the sector, (e.g. if a mode2 se
of form1 or form2). To write mode2 sectors onto a disc the presence of the subhea
mandatory.

TOC

The TOC is the table of contents of a disc. Each session and each track has its en
each track, Index 1 is listed in the TOC, but neither their end nor their pause. The
also contains the Media Catalog Number.

Track

A track is the smallest logical unit of a CD. Its minimum length is 600 sectors. A CD
have a maximum of 99 tracks. There are three physical types of tracks: Audio tr
CD-ROM tracks, and XA / CD-i TRACKS. Before each track, 150 empty sectors m
be placed (in track 1 these sectors represent the TOC) for the track-at-once mod
disc is written in disc-at-once mode these 150 sectors are only mandatory before th
track.
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Track-At-Once

With track-at-once mode recording, only one track is written to the disc without an
interruption of the laser. Between tracks, the write laser always stops writing. This is
why run-out sectors appear on the disc after each track.

Video CD

A Video CD consists of one ISO 9660 XA track and one or several MPEG tracks. These
kinds of discs can be read by a Video CD player and are normally used to store movies.

White Book

White Book standard describes the standard for Video CDs

XA / CD-i Tracks

These tracks only consists of mode2 sectors. They are used for ISO 9660 XA, CD-i,
Video CD and Photo CD systems

Yellow Book

The Yellow Book standard describes the standard for CD-ROMs. These parameters
ensure that CD-ROMs can be played back by all CD-ROM drives. It does not specify the
file structure.
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